
.

 

www.cypress.com 文書番号: 002-15741 Rev.*B 1 

AN97060 

PSoC® 4 BLE および PRoC™  BLE –  無線  (OTA) のデバイス  ファームウェア  

アップグレード (DFU) ガイド 

著者: Deepak John 

関連製品ファミリ: すべての PSoC 4 BLEおよび PRoC BLE 

関連サンプル コード: CE95351 

関連アプリケーション  ノート: 完全な一覧はこちらをクリックしてください。本アプリケーション  ノートの最新版 

または関連プロジェクトファイルは http://www.cypress.com/go/AN97060 をご覧ください。 
  

AN97060は PSoC® 4および PSoC™ BLEデバイスに基づくアプリケーション用の無線 (OTA) のファームウェア アップグレ

ード機能を実装するガイドラインを提供します。  

目次 

1 はじめに ....................................................................... 2 
2 PSoCおよび PRoCリソース ......................................... 2 
3 PSoC Creator .............................................................. 4 
4 BLE OTAブートローダ .................................................. 5 

4.1 外部メモリ OTAブートローダ ................................ 6 
4.2 固定スタック OTAブートローダ ............................. 7 
4.3 アップグレード可能スタック OTAブートローダ ........ 8 

5 ターゲット プロジェクトへのファームウェア OTA ブート 

ローダの追加 .............................................................. 10 
5.1 基本的なサンプル ターゲット プロジェクトの作成 .. 10 
5.2 外部メモリ OTAブートローダの追加 .................... 13 
5.3 固定スタック OTAブートローダの追加 ................. 16 
5.4 アップグレード可能スタック OTA ブートローダの 

追加 ................................................................... 22 
6 OTAアップグレードの実行 .......................................... 30 

6.1 Bootloader Hostツールによるアップグレード ...... 31 
6.2 CySmart PCツールによるアップグレード ............ 32 
6.3 CySmartモバイル アプリによるアップグレード ..... 33 

7 OTA機能のテスト ....................................................... 33 
8 その他の注意事項 ...................................................... 34 

8.1 ボンディング／ペアリングの情報 ......................... 34 
8.2 デバッグ ............................................................. 35 
8.3 データ長拡張 (DLE) ........................................... 36 
8.4 データの永続性 .................................................. 37 

9 まとめ ......................................................................... 39 
10 関連アプリケーション ノート ......................................... 39 
A 付録 A ........................................................................ 40 

A.1 サンプル プロジェクト ワークスペースの作成 ....... 40 
A.2 既存のワークスペースへのサンプル プロジェクトの

追加 ................................................................... 41 
A.3 他のデバイス選択 .............................................. 43 
A.4 ブートローダ サービスの追加 .............................. 45 
A.5 サイプレスの他の BLE デバイス用の固定スタック

OTAプロジェクトの設定 ...................................... 47 
改訂履歴 .......................................................................... 50 
ワールドワイドな販売と設計サポート ................................. 51 

  

http://www.cypress.com/
http://www.cypress.com/psoc4ble/?source=an97060
http://www.cypress.com/PRoCBLE/?source=an97060
http://www.cypress.com/?rid=105759&source=an97060
http://www.cypress.com/go/AN97060


  PSoC® 4 BLEおよび PRoC™ BLE – 無線 (OTA) のデバイス ファームウェア アップグレード (DFU) ガイド 

www.cypress.com 文書番号: 002-15741 Rev.*B 2 

1 はじめに 

無線 (OTA) のデバイス ファームウェア アップグレードは基本的に無線リンクを使用してターゲット デバイスのファームウェア

を更新するブートロード メカニズムです。OTA は任意の無線リンクで実行できますが、本アプリケーション ノートで言及する

OTA は Bluetooth® Low Energy (BLE) リンクで実行されるものを意味します。BLE デバイスの OTA 機能は、デバイスの 

機能をアップグレードするか、すでに現場で展開されたデバイスのファームウェアの問題を修正する際に役立ちます。 

本アプリケーション ノートでは、さまざまな OTA アップグレード オプションおよびユーザーの製品に適切なオプションを選択 

する方法を簡単に説明します。また、本書は最終製品での機能の統合および展開を支援するテストおよびトラブルシュー 

ティングの詳細な情報も提供します。  

本アプリケーション ノートをお読みになる前に、ブートローダ理論および技術について簡単に紹介し、PSoC Creator™を使用

して PSoC 3、PSoC 4 および PSoC 5LP デバイスでブートローダを迅速かつ簡単に実装する方法を示す AN73854 を 

お読みください。  

本アプリケーション ノートで説明される OTA機能に加えて、PSoCブートローダを使用することにより UART、I2Cや SPIなど

の他のインターフェースを介して PSoC 4 BLE および PRoC BLE デバイス (詳細は「PSoC および PRoC リソース」を参照 

してください) のファームウェアを更新できます。「関連アプリケーション ノート」を参照してください。本アプリケーション ノートで

は、BLEによる OTA機能を説明します。 

PSoC Creator のメニュー オプション File > Code Example…を選択し、ブートローダに関するサンプル プロジェクトに 

アクセスできます。ポップアップ ウィンドウで「bootloader」を検索してください。 

2 PSoCおよび PRoC リソース 

サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーがデザインに適切な PSoC (プログラマブル 

システム オン チップ) および PRoC (プログラマブル ラジオ オン チップ) デバイスを選択し、迅速かつ効率的にデバイスを 

デザインに統合できます。リソースの包括的な一覧は「KBA86521, How to Design with PSoC 3, PSoC 4, and PSoC 5LP」

を参照してください。以下は PSoC 4 BLEおよび PRoC BLEのリソースの要約です。 

▪ 概要: Bluetooth Low Energy ポートフォリオ、 

サイプレス ワイヤレス／RFロードマップ 

▪ 製品セレクタ: PSoC 4 BLEまたは PRoC BLE。

また、PSoC Creator にはデバイス選択ツール

が含まれています。 

▪ データシート: PSoC 4 BLE および PRoC BLE

デバイス ファミリの電気的仕様を説明します。 

▪ CapSense®デザイン ガイド: PSoC 4、PSoC 4 

BLE、および PRoC BLE ファミリのデバイスを 

使用して静電容量タッチセンシング アプリケー 

ションを設計する方法について説明します。 

▪ アプリケーション ノートおよびサンプル コード: 

基本レベルから上級レベルまでの幅広いトピック

に触れています。多くのアプリケーション ノート

はサンプル コードを含みます。 

▪ テクニカル  リファレンス  マニュアル  (TRM):  

各 PSoC 4 BLE および PRoC BLE デバイス 

ファミリのアーキテクチャおよびレジスタの 

詳細な説明を提供します。 

▪ 開発キット: 

 CY8CKIT-042-BLE および CY8CKIT-042-

BLE-A の BLE Pioneer Kit を使用し、 

PSoC 4 BLEおよび PRoC BLEデバイスを

使って BLE アプリケーションを評価し、 

開発できます。 

 CY5682 PRoC BLE タ ッ チ  マ ウ ス 

リファレンス デザイン キットを使用し、BLE

または Bluetooth Smart タッチ  マウスの 

完全な量産品の開発が可能です。 

 CY5672 PRoC BLE リモコン リファレンス 

デザイン  キットを使用し、BLE または

Bluetooth Smart リモコンの完全な量産品

の開発が可能です。 

 CY8CKIT-042 および CY8CKIT-040 の

PSoC 4 Pioneer Kit は使いやすく安価な 

開発プラットフォームです。これらのキットに

は Arduino™準拠シールドおよび Digilent® 

Pmod™ドーター  カードの専用コネクタを 

搭載します。 

 CY8CKIT-049 は、PSoC 4 デバイスを 

サンプリングできる低コスト  プロトタイプ 

プラットフォームのシリーズです。 

 CY8CKIT-001 は、すべての PSoC デバイ

ス ファミリの共通開発プラットフォームです。 

▪ MiniProg3 デバイスは、フラッシュのプログラミン

グとデバッグ用のインターフェースを提供します。 
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▪ CySmart™は Windows PC 用の BLE ホスト 

エミュレーション ツールです。このツールは、

BLE ペリフェラル  アプリケーションをテスト 

およびデバッグするための使いやすい GUI を 

提供します。 

▪ CySmart モバイル アプリはサイプレスが開発 

した BLE または Bluetooth Smart ユーティリ 

ティです。CySmart はさまざまな BLE 製品との

接続に使用し、また CY8CKIT-042-BLE PSoC 

4 BLE Pioneer Kit、CY5672 PRoC BLEリモコ

ン リファレンス デザイン キット、および CY5682 

PRoC BLEタッチ マウス リファレンス デザイン 

キットを含むサイプレスの BLE開発キットと併用

できます。 

▪ サイプレスのカスタム BLEプロファイルとサービ

ス: サイプレスの BLE コンポーネント (PSoC 

Creator の一部として使用される) は Bluetooth 

Special Interest Group (SIG) によって導入され

た GATTベースの BLEプロファイルおよびサー

ビスを含むように定期的に更新されます。

Bluetooth SIG によって定義されたプロファイル

およびサービス以外に、サイプレスはいくつかの

カスタム BLE プロファイルおよびサービスを 

定義しました。これにより、Bluetooth SIG に 

よって指定された標準 BLE プロファイルおよび

サービスがサポートしていない機能に対して 

データを BLE 経由で送信できます。これらの 

プロファイルおよびサービスは、サイプレス BLE

デバイスと通信するデバイス、または互いに 

通信するサイプレス BLE デバイスによって利用

できます。 
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3 PSoC Creator 

PSoC Creatorは無償のWindowsベースの統合開発環境 (IDE) です。これは、PSoC 3、PSoC 4、PSoC 4 BLE、PRoC 

BLEおよび PSoC 5LPベース システムのハードウェアとファームウェアの同時設計を可能にします。図 1を参照してください。

PSoC Creatorにより、以下のことが可能です。 

1. コンポーネントをドラッグ＆ドロップし、メイン 

デザイン  ワークスペースでハードウェア 

システム デザインを構築 

2. PSoC ハードウェアとアプリケーション ファーム

ウェアを同時設計 

3. コンフィギュレーション ツールを用いてコンポー

ネントを設定 

4. 100 以上のコンポーネントを含むライブラリを 

利用 

5. コンポーネント データシートを閲覧 

図 1. PSoC Creatorの特長 

http://www.cypress.com/
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4 BLE OTAブートローダ 

以下の用語は本書で頻繁に使用されています。これらの定義を理解することは、本アプリケーション ノートの理解に重要です。  

▪ ブートローダ: フラッシュ メモリの更新方法を知っており、その責任を担うファームウェアの一部です。 

▪ ブートローダブル: 無線で受信され、ターゲット デバイスのフラッシュ メモリで更新されるアプリケーションを含むファーム

ウェアの一部です。 

▪ ランチャー: 通信コンポーネントなしでブートローダ コンポーネントを組み込むことによって定義されているブートローダで

す。ランチャーは [ランチャー＋コピアー] として構成することもできます。コピアーは、以前に保存されたスタック 

アプリケーション (BLE スタックを含む PSoC Creator プロジェクト) イメージを一時的位置からスタック アプリケーション 

フラッシュ空間にコピーする (旧スタック アプリケーションを上書きする) 追加の機能 (ランチャーに備えられる) です。 

ターゲット MCU におけるフラッシュ メモリは、図 2 に示すように、2 つのセクションに分割されています: アプリケーション 

(ブートローダブル イメージ) とブートローダです。このアーキテクチャの他のバリエーションは特定のニーズを満たすために 

利用可能です。ブートローダおよびその機能フローの実装の詳細は AN73854 とブートローダおよびブートローダブル 

コンポーネント データシートを参照してください。 

図 2. BLEブートローダ システム 

 

データ (ブートローダブル部分) をホスト (PC またはスマートフォン) からターゲット デバイスのフラッシュに転送するプロセス

は「ブートローディング」 (「ブートロード動作」または単に「ブートロード」)、「ファームウェア アップグレード」、または「デバイス 

ファームウェア アップグレード (DFU) 」と呼びます。ブートローディングのもう 1 つの用語は「インシステム プログラミング 

(ISP)」です。  

サイプレスは、OTA のアップグレードを可能にする任意の BLE プロジェクトに追加できる 3 種類の BLE ブートローダを 

提供します。  

▪ 外部メモリ OTAブートローダ 

▪ 固定スタック OTAブートローダ 

▪ アップグレード可能スタック OTAブートローダ 
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それぞれのブートローダは利点と欠点を持っています。ここでは、それらのブートローダのアーキテクチャおよび他の設計上

の考慮事項について簡単に説明します。ここで述べられる情報に基づいて、ユーザーは設計に最適なブートローダを選択で

きます。 

4.1 外部メモリ OTAブートローダ 

外部メモリ OTA ブートローダは PSoC Creator で提供されているブートローダおよびシングル ブートローダブル イメージ 

アーキテクチャを使用します。これはブートローダブル イメージを一時的に格納するための外部メモリを使用します。BLE 

スタックはファームウェアのブートローダブル セクションに位置します。図 3 を参照してください。したがって、ファームウェアの

アップグレードによりアプリケーションと BLEスタックの両方がアップグレードされます。 

例えば、外部メモリは BLE Pioneer Kit の I2C バスを介して PSoC／PRoC BLE デバイスに接続されます。PSoC／PRoC 

BLEデバイスは I2Cマスターであり、外部メモリ デバイス (F-RAM™) は I2Cスレーブです。 

外部メモリ OTA ブートローダ実装では、ブートロードは 2 段階で行われます。段階 1 では、デバイスのフラッシュ メモリに 

存在しているブートローダブル アプリケーションは BLE を介して新しいブートローダブル イメージを受信します。アプリケー 

ション イメージの各チャンクは、受信されると、検証され、I2C を介して外部メモリに書き込まれます。ブートローダブル 

イメージが正常に受信されると、ファームウェアはブートローダ セクションに制御を渡します。 

段階 2では、ブートローダは新しいアプリケーション イメージ (段階 1で受信した) でデバイス フラッシュを再プログラムします。

プロセス全体は図 3に示されています。矢印はデータ フローの方向を示します。 

図 3. 外部メモリ OTAブートロード プロセス 

 
利点 

▪ BLE スタックとアプリケーションを一緒にアップ 

グレードできます。 

▪ ブートローダとブートローダブルがメモリを共有 

しない 2 つの個別プロジェクトであるため、 

ファームウェアは簡単に実装できます。 

欠点 

▪ 外部メモリを必要とします。外部メモリの目的が

OTA を有効にすることだけであれば、これは 

課題 (BOMの増加) です。 

▪ ファームウェアのアップグレードは他の OTA 

ブートローダに比べてより長い時間がかかり 

ます。原因としてイメージは、I2C を使用して外部メ

モリ デバイスに保存され、そこから取得されるため

です。 

▪ I2C に関するコードは、ブートローダとブート 

ローダブル両方のエリアにあるため、フラッシュの

使用量が増えます。 

 

外部メモリ OTAブートローダはサイプレスのプログラマブル BLE製品と共に使用できます。 

Bootloadable 

ブートローダ 

I2Cマスター 

BLEスタック 

外部メモリ 

(例: F-RAM) 

I2Cマスター 

ブートローディング 

ユーティリティ 
段階 1 

段階 1 

段階 1 

段階 2 

段階 2 
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4.2 固定スタック OTAブートローダ 

外部メモリ ブートローダの方法と同様に、固定スタック OTA ブートローダも PSoC Creator のブートローダおよびシングル 

ブートローダブル イメージ アーキテクチャを使用します。しかし、BLE スタックはブートローダ メモリ内に位置しているため、

OTA アップグレードを介してアップグレードできません。ブートローダブル  アプリケーションはブートローダ  メモリに 

位置している BLE API (BLEコンポーネント データシートを参照してください) に接続する必要があります。 

理想的には、ブートローダとブートローダブル イメージ (2 つの PSoC Creator プロジェクトで実装された) はそれら自身の

BLE スタックのコピーを持つ必要がありますが、これはメモリ消費量を増加させます。実用的な方法として、スタックを 

共有することで、ブートローダとブートローダブル プロジェクトは BLE コンポーネントに関連するコードを再利用できます。 

これにより、ファームウェアのアプリケーション部分によって使用できるフラッシュのかなりの量を節約できます。このアーキテ

クチャは次のようにファームウェアのアップグレード プロセスを簡略化します。 

固定スタック OTA ブートローダ実装では、ブートロードは 1 段階で行われます。ファームウェアはブートローダ モードに直接

入り、アプリケーション イメージが BLE リンクを介して受信されるまで待機します。検証が成功した後、受信されたアプリケー

ション イメージはブートローダブル エリアに直接書き込まれます。図 4 に、データ フローを示す矢印で、固定スタック OTA 

ブートロード プロセスを示します。 

図 4. 固定スタック OTAブートロード プロセス 

 

 

利点 

▪ BLE スタックはブートローダとブートローダブル 

プロジェクトで再利用されるため、フラッシュ メモリ

使用量を節約できます。 

▪ 受信されたアプリケーション イメージがフラッシュ 

メモリに直接書き込まれるため、アップグレード 

時間は短くなります。 

▪ 外部メモリまたはストレージは必要ありません。 

▪ 現行のイメージが無効になってもアプリケーション 

イメージのアップグレードは可能です。  

欠点 

▪ BLE スタックはブートローダの一部になり、OTA を

介してアップグレードすること (BLE プロファイルを

含む) はできません。 

 

BLEスタックは、フラッシュ メモリ内のブートローダ エリアにあります。これは、OTAファームウェアのアップグレード中は変更

されません。したがって、ブートローダは常に回復し、有効なアプリケーション イメージがなくなっても、いつでも OTA アップ 

グレードができる状態になっています。固定スタック OTA ブートローダはサイプレスのプログラマブル BLE 製品と共に使用 

できます。 

 
 
 
 

ブートローダブル 

ブートローダ 

ブートローディング 

ユーティリティ 
BLE 
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4.3 アップグレード可能スタック OTAブートローダ 

アップグレード可能スタック OTAブートローダはデュアル アプリケーション イメージ アーキテクチャを使用します。このアーキ

テクチャでは、利用可能なフラッシュはランチャー＋コピアーのイメージ (以下、「ランチャー」という)、スタック アプリケーション 

イメージ、およびユーザー アプリケーション イメージの 3つのセクションに分けられています (図 5を参照してください)。 

ランチャーのイメージは、フラグやイメージの有効性に応じて、スタック アプリケーションまたはユーザー アプリケーションの 

いずれかを開始します。スタック アプリケーションの更新中にランチャーは、最新のスタック アプリケーション イメージ (BLE 

リンクでダウンロードされ、一時的な[ユーザー アプリケーション] に保存された) をフラッシュのスタック アプリケーション 

位置にコピーします。 

スタック アプリケーション イメージは、スタック アプリケーション イメージとユーザー アプリケーション イメージ間で共有される

必要な BLE スタックまたは他のコードを含みます。スタック アプリケーションはユーザー アプリケーション イメージのアップ 

グレードを行います。また、スタック アプリケーション イメージの新しいバージョンをダウンロードしてフラッシュのユーザー 

アプリケーション領域に一時的に保存します。 

ユーザー アプリケーションは心拍数センサー、リモコン、マウスなどの最終アプリケーションの機能を実現します。これは 

スタック アプリケーション イメージに位置する BLE API (BLEコンポーネント データシートを参照してください) に接続します。

これにより、スタック (および／またはこの領域内の他のコード) をスタック アプリケーションとユーザー アプリケーション間で

共有できます。 

理想的には、スタック アプリケーション イメージとユーザー アプリケーション イメージ (2 つの PSoC Creator プロジェクトで 

実装された) はそれら自身の BLE スタックのコピーを持つ必要がありますが、これはメモリ消費量を増加させます。スタック 

(および／または他のコード) を共有することで、スタック アプリケーションとユーザー アプリケーションが BLE スタックに 

関するコードを再利用できます。これにより、アプリケーション イメージによって使用できるフラッシュのかなりの量を節約 

します。このアーキテクチャも 2つのファームウェア アップグレード オプションを提供します。 

▪ アプリケーション アップグレード: ユーザー アプリケーション イメージのみがアップグレードされます。アプリケーション 

アップグレードは 1 段階で行われます。OTA アップグレード モードに入るには、ファームウェアは新しいユーザー アプリ

ケーション イメージを受け取るスタック アプリケーションに制御を渡します。その後、スタック アプリケーションは対応する

フラッシュ領域にその新しいユーザー アプリケーション イメージを直接書き込みます (図 5を参照してください)。 

▪ スタック アップグレード:  スタック アプリケーションとユーザー アプリケーションは両方ともアップグレードされます。 

 段階 1: ファームウェアはスタック アプリケーションに制御を渡します。スタック アプリケーションは、新しいスタック 

アプリケーション イメージを受信してフラッシュ メモリ内の一時的位置 (ユーザー アプリケーション領域) に書き込み

ます。この段階ではユーザー アプリケーションが破損しています (新しいスタック アプリケーション イメージは既存の

ユーザー アプリケーション イメージを上書きします)。  

 階段 2: ダウンロードが完了した後、スタック アプリケーションはソフトウェア リセットを開始し、制御はランチャー 

イメージに渡されます。これは、一時的位置 (ユーザー アプリケーション領域) にあるイメージを検出し、スタック 

アプリケーション領域にコピーします (図 5 を参照してください)。ここでユーザー アプリケーション イメージが 

破損しているため、アプリケーション アップグレードも実行する必要があります。  

  

http://www.cypress.com/
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図 5. アップグレード可能スタック OTAブートロード プロセス 

 

利点 

▪ BLE スタックとアプリケーション イメージの両方

を更新する柔軟性を提供します。 

▪ この方法では BLE スタックが再利用されるため、

フラッシュ メモリの消費量を減らせます。 

▪ 受信される BLE スタック／アプリケーション 

イメージがフラッシュに直接書き込まれるため、

アップグレードの時間は短くなります。 

▪ 外部メモリまたはストレージは必要ありません。 

 

欠点 

▪ BLE スタックがアップグレードされているとき、

BLE スタックの新しいコピーを格納するために 

大容量 (256KB) のフラッシュ デバイスを使用 

する必要があります。 

 

 

 

 

 

 

アップグレード可能スタック OTA は BLE スタックとブートローダブル／アプリケーション イメージの両方をアップグレードする

ことを可能にします。さらに、(ダウンロード中に) BLEスタック イメージを一時的にフラッシュに格納する必要があるため、大容

量のフラッシュ デバイスを必要とします。そのため、アップグレード可能スタック OTA ブートローダのオプションは、サイプレス

の 256KBの BLE製品のみで使用できます。 

ユーザー アプリケーション 

ランチャー＋コピアー 

(BLE) 

スタック アプリケーション 

ブートローディング 

ユーティリティ 

スタック 

アップグレード 

(段階 2) 

スタック 

アップグレード 

(段階 1) 

アプリケーション 

アップグレード 
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5 ターゲット プロジェクトへのファームウェア OTAブートローダの追加 

ここではターゲット プロジェクトに OTAブートローダを追加する方法について説明します。これを実現するために、サンプルの

ターゲット プロジェクトを作成してから、このターゲット プロジェクトに OTA ブートローダを追加します (すべての 3 種類の

OTAブートローダを追加する手順は個別に説明されます)。  

PSoC Creator は OTA 対応サンプル プロジェクトを提供しています。図 6 に示すように、File > Example Project…を 

選んで、適切な Device Family とキーワードによる Filter by を選択することで、それらのサンプル プロジェクトにアクセス 

できます。各サンプル プロジェクトには、それぞれの資料が付属しています。特定の実装情報は資料をお読みください。 

ここでは、非 OTA アプリケーション ファームウェアに OTA 機能を追加する方法について説明します。ブートローダの異なる

種類は「BLE OTAブートローダ」を参照してください。 

図 6. BLEサンプル プロジェクト 

 

5.1 基本的なサンプル ターゲット プロジェクトの作成 

OTA ブートローダを追加できる基本のサンプル プロジェクトを用意する必要があります。このために、スタート ポイントとして

PWMExampleプロジェクトを使用します。このプロジェクトは、PRoC BLE／PSoC 4 BLE内の PWMコンポーネントを使って

LED輝度調整を実装します。PSoC 4 BLE／PRoC BLEデバイス用の PWMExampleプロジェクトを作成するには、以下の

手順に従ってください。いずれの OTAブートローダを追加したいプロジェクトがすでにあった場合、本節を飛ばしてください。 

1. PSoC Creatorで、File > Code Example …を選択します。図 7に示す Find Example Projectダイアログが開きます。 

http://www.cypress.com/
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2. 図 7に示すように、Find Example Projectダイアログで、Device Familyフィルターを PSoC 4200 BLEに、Filter by

のキーワードを PWMExampleに設定します。  

3. 一覧から PWMExampleプロジェクトを選択して Create New Projectをクリックします。 

4. Workspace フィールドで Create New Workspace オプションを選択します。新しいサンプル プロジェクトのワーク 

スペース用のロケーションを選択して (図 8を参照してください)、Finishをクリックします。 

図 7．Find Example Projectダイアログ 

 

図 8. Create Projectダイアログ 

 

2 

3 
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5. Workspace Explorer からファイルをダブルクリックして PWMExample01.cydwr ウィンドウを開きます。

LED_GREEN のデフォルトのポート割り当てを P3[6]に変更します (表 1 を参照してください)。この変更は、プロジェクト

を移植して CY8CKIT-042-BLE Pioneer Kit で動作させるために必要です。ポート P3[6]はキット上の緑色 LEDに接続

されます。 

ターゲット アプリケーションに適切なデバイスを変更／選択するために「他のデバイス選択」の手順に従ってください。 

6. LFCLKソースをWCO (32.768kHz) に変更します。  

a. PWMExample01.cydwr を開いて、Clocks タブに移動して、Edit Clock…をクリックして、Configure System 

Clocksダイアログを開きます。  

b. Configure System Clocksダイアログで、Low Frequency Clocks タブに移動して、LFCLKソースを変更します 

(図 9を参照してください)。 

7. プロジェクトを保存します。 

表 1. PWMExample01用のピン マッピング 

ピン名 ポートの割り当て 

LED_GREEN P3[6] 

図 9. LFCLKの選択 

 
 

ここで、ターゲット BLE デバイスで動作できる基本的な PWM サンプル プロジェクトをセットアップできました。サンプル 

プロジェクトがどのように動作するかを理解するために、ターゲット  デバイスをビルドし、プログラムできます (ビルドと 

プログラムを同時に行うために Debug > Program を選択します)。PSoC Creator と CY8CKIT-042-BLE Pioneer Kit の 

プログラミングの詳細は、AN91267と AN94020を参照してください。 

LED の動作は、main.c にある BRIGHTNESS_DECREASE マクロの値を変更することによって制御できます。この 

マクロ値は 0～63000 の間で定義できます。値が小さいほど輝度調光サイクル速度が遅くなり、値が高いほど輝度調光 

サイクル速度が速くなります。 

http://www.cypress.com/
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5.2 外部メモリ OTAブートローダの追加 

「基本的なサンプル  ターゲット  プロジェクトの作成」で用意した PWMExample プロジェクトに外部メモリ OTA 

ブートローダを追加する方法について説明します。BLE外部メモリ ブートローダおよびブートローダブル サンプル プロジェクト

のデータシートおよびソースコードを参照することも必要です。 

CY8CKIT-042-BLE Pioneer Kit では、I2C ベースの F-RAM が外部メモリとして使用されます。ただし、外部メモリ OTA 

ブートローダは I2C や SPI などのインターフェースを使用するフラッシュなどの他のメモリ種類でも動作できます。SPI ベース

の外部メモリ OTAブートローダの例はこちらを参照してください。 

PSoC 4 BLE Pioneer Kit用の PWMExampleプロジェクトで I2Cベースの外部メモリ ブートローダをセットアップするために

以下の手順に従ってください。  

1. PSoC Creatorで作成した PWMExample01プロジェクトを開きます (「基本的なサンプル ターゲット プロジェクトの作成」

を参照してください)。  

2. PWMExample01 ワークスペースに BLE 外部メモリ ブートローダの例を追加します (「既存のワークスペースへのサン

プル プロジェクトの追加」を参照してください)。 

3. Workspace Explorerで BLE_External_Memory_Bootloader01プロジェクトを右クリックして Set As Active Project

を選択することにより、このプロジェクトをアクティブなプロジェクトとして設定します。 

4. ターゲット アプリケーションに適切なデバイスを変更／選択するために「他のデバイス選択」の手順に従ってください。 

5. Build > Build BLE_External_Memory_Bootloader01 を 選 択 し て BLE_External_Memory_Bootloader01 

プロジェクトをビルドします。プロジェクトはエラーなしでビルドされます。 

6. PSoC Creator の他のインスタンスを開き、BLE 外部メモリ ブートローダブル サンプル プロジェクト用に新しいワーク 

スペースを作成します (「サンプル プロジェクト ワークスペースの作成」を参照してください)。外部メモリ ブートローダを有

効にするために、このプロジェクトからのファイルとコードが必要です。 

7. PWMExample01プロジェクトをアクティブなプロジェクトとして設定します。 

8. 次のコンポーネントを、ステップ 6で作成した BLE外部メモリ ブートローダブル プロジェクトの TopDesign.cyschから、

「基本的なサンプル ターゲット プロジェクトの作成」で作成した PWMExample01 プロジェクトの TopDesign.cysch 

ファイルにコピーします。このステップで追加されるコンポーネントのコンフィギュレーションは BLE 外部メモリ 

ブートローダブル サンプル プロジェクトのデータシートで説明されています。 

▪ BLE 

▪ Bootloader_Service_Activation 

▪ Bootloading_LED 

▪ Advertising_LED_1 

▪ Bootloadable 

▪ EMI_I2CM 

▪ UART 

▪ WDT 

▪ WDT_Interrupt 

▪ Wakeup_Interrupt 

ユーザーのプロジェクトには BLE コンポーネントがすでに含まれている場合、このステップの BLE コンポーネントを省略

し、その代わりに、「ブートローダ サービスの追加」で述べた手順に従って、既存の BLE コンポーネントのブートローダ 

サービスを追加し、設定してください。 

外部メモリ OTA を実装するために BLE、EMI_I2CM、および Bootloadable コンポーネントが必要です。

Bootloader_Service_Activation および Wakeup_Interrupt は、ブートローダ モードに入るためのトリガーとして使用 

されます 。ユーザーのプロジ ェ ク ト にはブー ト ローダ  モー ドに入る他のメ カニズムがある場合 、

Bootloader_Service_Activation および Wakeup_Interrupt コンポーネントをコピーしないでください。UART コンポー 

ネントはデバッグ メッセージを表示するために使用されます。他のすべてのコンポーネントは外部メモリ OTA の実装に

不要であるため、このステップを無視してもかまいません。しかし、これらはコンパイル時のエラーを防ぐために必要です。 

このステップの終わりにおいて、ユーザーの回路図は図 10のようになります。 

http://www.cypress.com/
http://www.cypress.com/documentation/datasheets/fm24v10-1-mbit-128-k-8-serial-i2c-f-ram
https://github.com/cypresssemiconductorco/PSoC-4-BLE/tree/master/100_Projects_in_100_Days/Project051_NOR_Flash_Bootloader
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図 10. 必要なコンポーネントを追加した後の TopDesign.cyschビュー 

 

9. BLE コンポーネント コンフィギュレーション ウィンドウ (BLE コンポーネントをダブルクリックしてください) の GAP 

Settings タブで、Device Nameを「External Memory OTA」に変更します 。図 11を参照してください。 

図 11. BLEコンポーネント コンフィギュレーション ウィンドウの GAP設定 

 

10. ブートローダ プロジェクトの HEXおよび ELFファイルへのパスを指定します。  

http://www.cypress.com/
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a. Bootloadableコンポーネントをダブルクリックします。  

b. 図 12に示すように、Dependencies タブに移動し、Bootloader HEX fileを

BLE_External_Memory_Bootloader01.hexファイル 

(\BLE_External_Memory_Bootloader01.cydsn\CortexM0\<compiler version>\<build configuration>\にある) 

にリンクさせます。 

HEXファイルを選択すると、対応する ELFファイルは自動的に選択されます。 

c. OKをクリックして Bootloadableコンポーネント コンフィギュレーション ダイアログを閉じます。 

図 12. Bootloadableコンポーネント コンフィギュレーション 

   

11. ステップ 8 で追加したコンポーネントに正しいピンを割り当るために、PWMExample01.cydwr を開いて Pins タブに 

移動します。表 2のとおりにピンを設定します。 

表 2. PWMExample01用のピン マッピング 

ピン名 ポートの割り当て 

EMI_I2CM:scl P5[1] 

EMI_I2CM:sda P5[0] 

UART:tx P1[5] 

Advertising_LED_1 P3[7] 

Bootloader_Service_Activation P2[7] 

Bootloading_LED P2[6] 

LED_GREEN P3[6] 

 

12. 次のファイルをブートローダブル プロジェクト ワークスペースのディレクトリから PWMExample01 プロジェクトのワーク

スペースのディレクトリにコピーし、これらを PWMExample01 プロジェクトに追加します。これらのファイルは OTA と 

デバッグ機能の一部を実装します。  

http://www.cypress.com/
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a. ヘッダ ファイルを追加するには、Workspace Explorer 内の Header Files フォルダを右クリックして、Add > 

Existing Item…を選択します。必要なファイルを選択して、Openをクリックします。 

b. ソース ファイルを追加するには、Workspace Explorer 内の Source Files フォルダを右クリックし、Add > 

Existing Item…を選択します。必要なファイルを選択して、Openをクリックします。 

▪ Common.h 

▪ debug.h 

▪ main.h 

▪ Options.h 

▪ OTAMandatory.h 

▪ OTAOptional.h 

▪ Common.c 

▪ debug.c 

▪ OTAMandatory.c 

▪ OTAOptional.c 

OTAMandatory.c／h ファイルは外部メモリ OTA を有効にするために必要な機能をすべて実装します。他のファイルは

必須ではありませんが、コンパイル時のエラーを防ぐためにコピーされます。debug.h／c ファイルは、UART ベースの 

デバッグ メッセージの表示を実装します。Common.c／h ファイルはウォッチドッグ タイマー (WDT)、LED、デバッグ 

メッセージ表示およびブートローダ サービス可視化の設定のためのヘルパー関数を実装します。main.h ファイルには、

LED の状態およびブートローダ サービスの有効化／無効化の定義が含まれています。Options.h ファイルには、 

デバッグおよび暗号化を有効／無効にする定義が含まれています。OTAOptional.c／h ファイルは外部メモリに 

格納されている情報の暗号化／復号を実装します。このために、Options.h の ENCRYPT_ENABLED マクロを YES に 

設定します。 

13. ブートロードまたは OTA機能を有効にするために、追加のコード (BLE外部メモリ ブートローダブル プロジェクトからの

コード) を PWMExample01 プロジェクトの main.c に追加する必要があります。変更点が多く、個別に記載することが 

できません。その代わりに、変更ファイルをダウンロードし、使用できます。PWMExample01 プロジェクトの main.c 

ファイルを\Code\External Memory OTA\のmain.cファイルに置き換えます。 

14. Bootloader／Bootloadable コンポーネントを追加した後、デバッグの対応は PSoC Creator で無効になります。しかし、

ファームウェアが実行を開始すると、ファームウェアをデバッグするために、ターゲット デバイスに接続し (Debug > 

Attach to Running Target…)、または UART メッセージングを使用します。UART が有効のとき、プロジェクトが 

正常に実行されるように十分なヒープ (0x400 バイト) とスタック (0×800 バイト) が設定されたことを確認してください。 

そうしないと、ファームウェアは予測できない動作となる場合があります。詳細は「デバッグ」を参照してください。 

15. Build > Build PWMExample01 を選択し、PWMExample01 プロジェクトをビルドします。PWMExample01 

プロジェクトはエラーなしでビルドされます。 

16. Debug > Programを選択し、PSoC BLE Pioneer Kitをプログラムします。 

プログラミングが完了した後、緑色 LED は高輝度から低輝度まで周期的に繰り返します。ここで、「OTA アップグレードの実

行」で述べた方法の 1 つで、デバイス ファームウェアのアップグレードを実行できます。また、「OTA 機能のテスト」で 

述べた手順に従って、OTA機能もテストできます。 

5.3 固定スタック OTAブートローダの追加 

「基本的なサンプル ターゲット プロジェクトの作成」で用意した PWMExample プロジェクトに固定スタック OTA ブートローダ

を追加する方法について説明します。また、BLE 固定スタック  ブートローダおよびブートローダブル  サンプル 

プロジェクトのデータシートおよびソースコードも参照する必要があります。PWMExample プロジェクトで固定スタック 

ブートローダをセットアップするために以下の手順に従ってください。 

注: 固定スタック OTA ブートローダのコード共有機能は、MDK MicroLIB リンカー オプションが選択された場合にサポート 

されません。そのため、Project > Build Settings の Use MicroLIB は False に設定する必要があります (図 13 を参照 

してください)。 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an97060-psoc-4-ble-and-proc-ble-over-air-ota-device-firmware-upgrade
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図 13. MDKリンカーのビルド設定 

 

 

1. PSoC Creatorで作成した PWMExample01プロジェクトを開きます (「基本的なサンプル ターゲット プロジェクトの作成」

を参照してください)。  

2. PWMExample01ワークスペースに BLE_OTA_FixedStack_Bootloaderの例を追加します (「既存のワークスペースへ

のサンプル プロジェクトの追加」を参照してください)。 

3. Workspace Explorer で BLE_OTA_FixedStack_Bootloader01プロジェクトを右クリックし、Set As Active Project

を選択することにより、このプロジェクトをアクティブなプロジェクトとして設定します。 

4. ターゲット アプリケーションに適切なデバイスを変更／選択するために「他のデバイス選択」の手順に従ってください。 

5. BLEコンポーネント コンフィギュレーション ウィンドウの GAP Settings タブで、Device Nameを「Fixed Stack OTA」に

変更します (図 14を参照してください)。BLEコンポーネント コンフィギュレーション ダイアログを開くには、BLEコンポー

ネントをダブルクリックします。 

http://www.cypress.com/
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図 14. BLEコンポーネント コンフィギュレーション ウィンドウの GAP設定 

 

ユーザーのブートローダブル プロジェクトには BLEコンポーネントが既にある場合、次のようにしてください。 

a. BLE_OTA_FixedStack_Bootloader01 プロジェクトの BLE コンポーネントをユーザーのブートローダブル 

プロジェクトの BLEコンポーネントに置き換えます。 

b. 既存の BLE コンポーネントにブートローダ サービスを追加し、設定します (「ブートローダ サービスの追加」を 

参照してください)。 

c. ブートローダブル プロジェクトの回路図から BLEコンポーネントを削除します。 

BLE コンポーネントの置き換えにより、新しい BLE コンポーネント コンフィギュレーションに応じて、コードに関連する 

サービス／プロファイルの一部は、コンパイル時のエラーを防ぐために削除または追加する必要があります。  

6. BLE OTA 固定スタックのサンプル プロジェクトはカスタム リンカー スクリプトを使用し、選択したデバイス用に設定 

される必要があります。このために、「サイプレスの他の BLE デバイス用の固定スタック OTA プロジェクトの設定」で 

述べた手順に従ってください。 

7. BLE_OTA_FixedStack_Bootloader01プロジェクトをビルドします。プロジェクトはエラーなしでビルドされます。 

8. PWMExample01.cydsnプロジェクト フォルダに新しいフォルダを作成し、「LinkerScripts」と名前を付けます。 

9. PSoC Creatorで、mk.batファイル (Workspace Explorer > BLE_OTA_FixedStack_Bootloader01 > Scripts > 

mk.bat) をダブルクリックして開きます。 

10. 表 3のとおりにファイルを編集し、保存します。LOADABLE_PRJ_NAME はブートローダブル アプリケーション名で割り当

てる必要があります (この場合は「PWMExample01」です)。 

  

http://www.cypress.com/
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表 3. mk.batの変更 

行番号 変数 値 

28 LOADER_PRJ_NAME BLE_OTA_FixedStack_Bootloader01 

30 LOADABLE_PRJ_NAME PWMExample01 

 

11. Windows Explorerから mk.batファイルを実行します。このファイルは

…\PWMExample01\BLE_OTA_FixedStack_Bootloader01.cydsn\Scriptsにあります。このバッチ ファイルはエラーな

しで実行されます。バッチ ファイルの実行が完了した後、任意のキーを押してウィンドウを閉じます。このステップでは、

\PWMExample01\PWMExample01.cydsn\LinkerScriptsの下に BootloaderSymbolsGcc.ldファイルが作成されま

す。 

12. PSoC Creator の他のインスタンスを開いて、BLE_OTA_FixedStack_Bootloadable サンプル  プロジェクト用の 

新しいワークスペースを作成します (「サンプル プロジェクト ワークスペースの作成」を参照してください)。固定スタック 

ブートローダを有効にするために、このプロジェクトからのファイルとコードが必要です。 

13. PWMExample01プロジェクトをアクティブなプロジェクトとして設定します。 

14. PWMExample01 プロジェクト用に PSoC Creator の Workspace Explorer で新しいフォルダを作成し、

「LinkerScripts」と名前を付けます。新しいフォルダを作成するには、Workspace Explorer 内のプロジェクト名を 

右クリックして、Add > New Folderを選択します。 

15. ステップ 12 で作成したブートローダブル サンプル プロジェクトには LinkerScripts フォルダがあります。このフォルダに

は、PSoC Creator がサポートするすべての 3 つのコンパイラ用のリンカー スクリプト (cm0gcc.ld、Cm0Iar.icf、および

Cm0Mdk.scat) が含まれています。ステップ 8 で PWMExample01 プロジェクトで作成された LinkerScripts フォルダに

3つのファイルをすべてコピーします。 

16. PSoC Creatorの PWMExample01プロジェクトのWorkspace Explorer内の (ステップ 14で作成した) LinkerScripts

フォルダに以下のファイルを追加します。ファイル システムでは、これらのファイルはステップ 8で作成した LinkerScripts

フォルダにあります。 

▪ BootloaderSymbolsGcc.ld 

▪ cm0gcc.ld 

▪ Cm0Iar.icf 

▪ Cm0Mdk.scat 

17. BLE OTA 固定スタックのサンプル プロジェクトはカスタム リンカー スクリプトを使用し、選択したデバイス用に設定 

される必要があります。このために、「サイプレスの他の BLE デバイス用の固定スタック OTA プロジェクトの設定」で 

述べた手順に従ってください。 

18. 次のコンポーネントを、ステップ 12 で作成した BLE_OTA_FixedStack_Bootloadable サンプル  プロジェクトの

TopDesign.cyschから、「基本的なサンプル ターゲット プロジェクトの作成」で作成した PWMExample01プロジェクトの

TopDesign.cysch ファイルにコピーします。このステップで追加したコンポーネントのコンフィギュレーションは BLE 

固定スタック ブートローダブル サンプル プロジェクトのデータシートで説明されています。コンポーネントは複数の回路図

ページにわたって広がる可能性があります。 

▪ Bootloadable 

▪ UART_DEB 

▪ WDT 

▪ WDT_Interrupt 

最終のブートローダブル プロジェクトの回路図には BLE コンポーネントがないことを確認してください。ブートローダブル 

プロジェクトに BLEコンポーネントが既にある場合、次のようにします。 

a. そのコンポーネントを BLE_OTA_FixedStack_Bootloader01プロジェクトに移動します。  

b. 既存の BLE コンポーネントにブートローダ サービスを追加し、設定します (「ブートローダ サービスの追加」を 

参照してください)。 

このステップの後に、ステップ 5 から繰り返して、ブートローダを更新し、新しいリンカー  スクリプトを生成します。 

ブートローダブル コンポーネントは固定スタック OTAを実装するために使用されます。他のすべてのコンポーネントは重

要ではないため、このステップで無視してもかまいません。しかし、これらはコンパイル時のエラーを防ぐために必要です。

UART コンポーネントはデバッグ メッセージを表示するために使用されます。必要であれば、WDT と WDT_Interruptは

プロジェクトでタイミングを実装します。  

http://www.cypress.com/
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このステップの終わりにユーザーの回路図は図 15 のようになります。ブートローダ プロジェクトの HEX ファイルと 

ELFファイルへのパスを指定します。 

a. Bootloadableコンポーネントをダブルクリックします。 

b. 図 16に示すように、Dependencies タブに移動し、Bootloader HEX fileを

BLE_OTA_FixedStack_Bootloader01.hexファイル 

(\BLE_OTA_FixedStack_Bootloader01.cydsn\CortexM0\\<compiler version>\<build configuration>\にある) 

にリンクさせます。 

c. OKをクリックして Bootloadableコンポーネント コンフィギュレーション ダイアログを閉じます。 

HEXファイルを選択すると、対応する ELFファイルは自動的に選択されます。 

19. ステップ 17 で追加したコンポーネント用に正しいピンを割り当るために、PWMExample01.cydwr を開き、Pins タブに 

移動します。表 4に示すようにピンを設定します。 

図 15. 必要なコンポーネントを追加した後の TopDesign.cyschビュー 

  

図 16. Bootloadableコンポーネント コンフィギュレーション 
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表 4. PWMExample01用のピン マッピング 

ピン名 ポートの割り当て 

UART_DEB:tx P1[5] 

LED_GREEN P3[6] 

 

20. 次のファイルを BLE 固定スタック  ブートローダブル  サンプル  プロジェクトのワークスペース  ディレクトリから

PWMExample01 プロジェクトのワークスペース ディレクトリにコピーし、それらを PWMExample01 プロジェクトに 

追加します。これらのファイルは OTAとデバッグ機能の一部を実装します。 

a. ヘッダ ファイルを追加するには、Workspace Explorer 内の Header Files フォルダを右クリックして、Add > 

Existing Item…を選択します。必要なファイルを選択して、Openをクリックします。 

b. ソース ファイルを追加するには、Workspace Explorer 内の Source Files フォルダを右クリックし、Add > 

Existing Item…を選択します。必要なファイルを選択して、Openをクリックします。 

▪ common.h 

▪ main.h 

▪ OTAMandatory.h 

▪ OTAOptional.h 

▪ debug.h 

▪ Options.h 

▪ OTAMandatory.c 

▪ OTAOptional.c 

▪ debug.c 

OTAMandatory.c／h ファイルは外部メモリ OTA を有効にするために必要な機能をすべて実装します。他のファイルは

必須ではありませんが、コンパイル時のエラーを防ぐためにコピーされます。debug.h／c ファイルは、UART ベースの 

デバッグ メッセージの表示を実装します。common.h ファイルには LED 状態および WDT オプションの定義が含まれて

います。Options.h ファイルには、デバッグを有効／無効にする定義が含まれています。OTAOptional.c／h ファイルは

WDT、LEDおよびデバッグ メッセージ表示のためのヘルパー関数を実装します。 

21. ブートロードまたは OTA 機能を有効にするために、追加のコード (BLE_OTA_FixedStack_Bootloadable プロジェクト

からのコード) を PWMExample01 プロジェクトの main.c に追加する必要があります。変更点が多く、個別に記載する 

ことができません。その代わりに、変更ファイルをダウンロードし、使用できます。PWMExample01プロジェクトの main.c

ファイルを\Code\Fixed Stack OTA\のmain.cに置き換えます。 

22. 表 5 に示す設定が PWMExample01 のビルド設定に適用されたことを確認してください。これらの変更は、新しい 

カスタム リンカー スクリプトを使用するようにリンカーに指示します。ビルド設定を変更するには、Project > Build 

Settings…を選択し、図 17 に示すように、ツリー ビュー ウィンドウで PWMExample01 > ARM GCC 4.9-2015-q1-

update > Linker > Generalを選択します。 

表 5. ビルド設定の変更 

フィールド 値 

Additional Library Directories .\LinkerScripts 

Custom Linker Script .\LinkerScripts\cm0gcc.ld 

http://www.cypress.com/
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図 17. Build Settingsダイアログのリンカー設定 

 
 

23. Bootloader／Bootloadable コンポーネントを追加した後、デバッグの対応は PSoC Creator で無効です。しかし、 

ファームウェアが実行を開始すると、ファームウェアをデバッグするために、ターゲット デバイスに接続し (Debug > 

Attach to Running Target…)、または UART メッセージングを使用します。UARTデバッグを有効／無効にする方法

は「デバッグ」を参照してください。UART が有効のとき、プロジェクトが正常に実行されるように十分なヒープ (0x400 バ

イト) とスタック (0×800バイト) が設定されたことを確認してください。そうしないと、ファームウェアは予測できない動作と

なる場合があります。詳細は「デバッグ」を参照してください。 

24. PWMExample01プロジェクトをビルドします。プロジェクトはエラーなしでビルドされます。 

25. Debug > Programを選択し、PSoC BLE Pioneer Kitをプログラムします。 

プログラミングが完了した後、緑色 LED は高輝度から低輝度まで周期的に繰り返します。ここで、「OTA アップグレードの実

行」で述べた方法の 1 つで、デバイス ファームウェアのアップグレードを実行できます。また、「OTA 機能のテスト」で 

述べた手順に従って、OTA機能もテストできます。 

5.4 アップグレード可能スタック OTAブートローダの追加 

「基本的なサンプル ターゲット プロジェクトの作成」で用意した PWMサンプル プロジェクトにアップグレード可能スタック OTA

ブートローダを追加する方法について説明します。また、BLE OTA アップグレード可能スタック  ランチャー、 

スタックおよびキーボード サンプル プロジェクトのデータシートおよびソースコードを参照することも必要です。PWMサンプル 

プロジェクトでアップグレード可能スタック メモリ ブートローダをセットアップするために以下の手順に従ってください。 

注: アップグレード可能スタック OTAブートローダのコード共有機能は、MDK MicroLIBリンカー オプションが選択された場合

にサポートされません。そのため、Project > Build Settingsの Use MicroLIBは Falseに設定する必要があります (図 18

を参照してください)。 
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図 18. MDKリンカーのビルド設定 

 

1. PSoC Creatorで作成した PWMExample01プロジェクトを開きます (「基本的なサンプル ターゲット プロジェクトの作成」

を参照してください)。 

2. PWMExample01 のワークスペースに BLE_OTA_UpgradableStackExample_Launcher の例を追加します (「既存の

ワークスペースへのサンプル プロジェクトの追加」を参照してください）。 

3. BLE_OTA_UpgradableStackExample_Launcher01 プロジェクトをアクティブなプロジェクトとして設定します。このため

に、Workspace Explorer内のプロジェクトを右クリックして、Set As Active Projectを選択します。 

4. ターゲット アプリケーションに適切なデバイスを変更／選択するために「他のデバイス選択」の手順に従ってください。 

5. BLE_OTA_UpgradableStackExample_Launcher01 プロジェクトをビルドします。プロジェクトはエラーなしでビルド 

されます。 

6. PWMExample01のワークスペースに BLE_OTA_UpgradableStackExample_Stackの例を追加します (「既存のワー

クスペースへのサンプル プロジェクトの追加」を参照してください)。 

7. BLE_OTA_UpgradableStackExample_Stack01プロジェクトをアクティブなプロジェクトとして設定します。 

8. ターゲット アプリケーションに適切なデバイスを変更／選択するために「他のデバイス選択」の手順に従ってください。 

9. ランチャー プロジェクトの HEXおよび ELFファイルへのパスを指定します。  

a. Bootloadableコンポーネントをダブルクリックします。 
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b. 図 19に示すように、Dependencies タブに移動し、Bootloader HEX fileを

BLE_OTA_UpgradableStackExample_Launcher01.hexファイル 

(\BLE_OTA_UpgradableStackExample_Launcher01.cydsn\CortexM0\\<compiler version>\<build 

configuration>\にある) にリンクさせます。 

c. OKをクリックして Bootloadableコンポーネント コンフィギュレーション ダイアログを閉じます。 

HEXファイルを選択すると、対応する ELFファイルは自動的に選択されます。 

図 19. Bootloadableコンポーネント コンフィギュレーション 

 

10. BLE_OTA_UpgradableStackExample_Stack01 プロジェクトをビルドします。プロジェクトはエラーなしでビルドされます。 

11. PSoC Creatorの他のインスタンスを開いて、BLE_OTA_UpgradableStack_HID_Keyboardサンプル プロジェクト用の

新しいワークスペースを作成します (「サンプル プロジェクト ワークスペースの作成」を参照してください)。アップ 

グレード可能スタック OTAブートローダを有効にするために、このプロジェクトからのファイルとコードが必要です。 

12. PWMExample01プロジェクトをアクティブなプロジェクトとして設定します。 

13. 次のコンポーネントを、ステップ 24 で作成した BLE_OTA_UpgradableStack_HID_Keyboard サンプル プロジェクトの

TopDesign.cysch ファイルから、「基本的なサンプル ターゲット プロジェクトの作成」で作成した PWMExample01 

プロジェクトの TopDesign.cysch ファイルにコピーします。このステップで追加したコンポーネント コンフィギュレーション

は BLE_OTA_UpgradableStack_HID_Keyboardサンプル プロジェクトのデータシートで説明されています。 

▪ CyBle 

▪ Bootloadable 

▪ UART 

▪ SW2 

▪ Wakeup_Interrupt 

ユーザーのプロジェクトに BLE コンポーネントが既にある場合、BLE コンポーネントが最新バージョンに更新され、

Profile onlyモードで設定されていることを確認してください (図 20を参照してください)。 
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図 20. BLEコンポーネント コンフィギュレーションの Profile Onlyオプション 

 

BLE およびブートローダブル コンポーネントはアップグレード可能スタック OTA を実装するために使用されます。他の 

すべてのコンポーネントはアップグレード可能スタック OTA の実装に不要であるため、このステップで無視しても 

かまいません。しかし、これらはコンパイル時のエラーを防ぐために必要です。UART コンポーネントはデバッグ 

メッセージを表示するために使用されます。SW2 および Wakeup_Interrupt はブートローダ モードに移行するトリガー 

として使用されます。ユーザーのプロジェクトは、ブートローダ モードに移行する他のメカニズムがある場合、SW2および

Wakeup_Interruptコンポーネントをコピーしないでください。 

このステップの終わりにおいて、ユーザーの回路図は図 21のようになります。 
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図 21. 必要なコンポーネントを追加した後の TopDesign.cyschビュー 

 

14. BLE コンポーネントの BLE_OTA_UpgradableStackExample_Stack01 の CyBle.cycsa ファイルへのパスを 

指定します。  

a. BLEコンポーネントをダブルクリックします。 

b. General タブに移動します。Over-The-Air bootloading with code sharing セクションで Profile only 

オプションを選択します。  

c. 図 20に示すように、Stack dependencyフィールドの CyBle.cycsaファイルを選択します。 

d.  CyBle.cycsaファイルは BLE_OTA_UpgradableStackExample_Stack01プロジェクト ディレクトリ下の

\Generated_Source\PSoC4\ディレクトリにあります。 

15. ランチャー プロジェクトの HEXと ELFファイルへのパスを指定します。  

a. Bootloadableコンポーネントをダブルクリックします。 

b. 図 22に示すように、Dependencies タブに移動し、Bootloader HEX fileを

BLE_OTA_UpgradableStackExample_Stack01.hexファイル 

(\BLE_OTA_UpgradableStackExample_Stack01.cydsn\CortexM0\\<compiler version>\<build 

configuration>\にある) にリンクさせます。 

c. OKをクリックして Bootloadableコンポーネント コンフィギュレーション ダイアログを閉じます。 

HEXファイルを選択すると、対応する ELFファイルは自動的に選択されます。 
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図 22．Bootloadableコンポーネント コンフィギュレーション 

  

16. ステップ 17 で追加したコンポーネント用に正しいピンを割り当るために、PWMExample01.cydwr を開き、Pins タブに 

移動します。表 6のとおりにピンを設定します。 

表 6. PWMExample01用のピン マッピング 

ピン名 ポートの割り当て 

UART:tx P1[5] 

LED_GREEN P3[6] 

SW2 P2[7] 

 

17. 次のファイルを BLE_OTA_UpgradableStack_HID_Keyboardサンプル プロジェクトのワークスペース ディレクトリから

PWMExample01 プロジェクトのワークスペース ディレクトリにコピーし、それらを PWMExample01 プロジェクトに 

追加します。これらのファイルは OTAとデバッグ機能の一部を実装します。 

a. ヘッダ ファイルを追加するには、Workspace Explorer 内の Header Files フォルダを右クリックして、Add > 

Existing Item…を選択します。必要なファイルを選択して、Openをクリックします。 

b. ソース ファイルを追加するには、Workspace Explorer 内の Source Files フォルダを右クリックし、Add > 

Existing Item…を選択します。必要なファイルを選択して、Openをクリックします。 

▪ OTAMandatory.h 

▪ debug.h 

▪ common.h 

▪ options.h 

▪ OTAMandatory.c 

▪ debug.c 

OTAMandatory.c／h のファイルはアップグレード可能スタック OTA を有効にする機能をすべて実装します。他の 

ファイルは必須ではありませんが、コンパイル時のエラーを防ぐためにコピーされます。debug.h／c ファイルは、UART

ベースのデバッグ メッセージの表示を実装します。common.h ファイルには LED 状態および WDT オプションの定義が

含まれています。options.hファイルには、デバッグを有効／無効にする定義が含まれています。 
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18. ブートロードまたは OTA 機能を有効にするために、追加のコード (BLE_OTA_UpgradableStack_HID_Keyboard 

プロジェクトからのコード) を PWMExample01プロジェクトの main.cに追加する必要があります。変更ファイルをダウン

ロードできます。PWMExample01プロジェクトの main.cファイルを\Code\Upgradable Stack OTA\からの main.cに

置き換えます。下記は (OTAに) 関連するコード部分の検証です。 

AfterImageUpdate() 関数は、アプリケーション イメージが更新され、初めて実行されるかどうかを確認します。 

アプリケーション イメージが初めて実行され、BLE コンポーネントの「Bonding requirement」オプションが「Bonding」に 

設定されている場合、この関数はボンディング データを検証し、無効の場合にはデータを消去します。また、未使用の 

メタデータ領域内で更新検出フラグをセットアップします。 

InitializeBootloaderSRAM() 関数は、コード共有に必要とされる BLE スタック SRAM を初期化するために 

使用されます。この関数は main 関数の初めに呼び出す必要があります。そうしないと、ファームウェアは予測できない

動作となる可能性があります。 

アプリケーション  イメージをスタック  アプリケーションに切り替えるために、まず、入力パラメーター0 で

Bootloadable_SetActiveApplication() を呼び出してスタックをアクティブなアプリケーションとして設定します。

次に、Bootloadable_Load() 関数を呼び出します。その後、CySoftwareReset() 使ってソフトウェア リセットを

行います。このシーケンスはコード 1 に示されます。このコード例では、SW2 の押下と解放はブートロード プロセスを 

開始するためのトリガーとして使用されます。 

コード 1. アプリケーション レベルのボンディング情報の書き込み 

/* For GCC compiler use separate API to initialize BLE Stack SRAM. 

 * This is needed for code sharing. 

 */ 

#if !defined(__ARMCC_VERSION) 

    InitializeBootloaderSRAM(); 

#endif 

 

 

/* Checks if Self Project Image is updated and Runs for the First time */ 

AfterImageUpdate(); 

 

/* Start CYBLE component and register generic event handler */ 

CyBle_Start(AppCallBack); 

 

while (1) 

{ 

    /* If key press event was detected - debounce it and switch to 

    bootloader emulator mode */ 

    if (SW2_Read() == 0u) 

    { 

        CyDelay(500u); 

        if (SW2_Read() == 0u) 

        { 

            CyDelay(500u); 

            while (SW2_Read() == 0u) 

            { 

                /* Wait for button to be released */ 

            } 

         

            //Switch to the Stack project, which enables OTA service 

            Bootloadable_SetActiveApplication(0); 

            Bootloadable_Load(); 

            CySoftwareReset(); 

        } 

    } 

}  
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19. PWMExample01.cydsnプロジェクトに新しいフォルダを作成し、「LinkerScripts」と名前を付けます。 

20. ステップ 11 で作成したブートローダブル サンプル プロジェクトには LinkerScripts フォルダがあります。このフォルダに

は、PSoC Creator がサポートするすべての 3 つのコンパイラ用のリンカー  スクリプト  (cm0gcc.ld および

Cm0Mdk.scat) が含まれています。ステップ 0 で PWMExample01 プロジェクトで作成した LinkerScripts フォルダに 3

つのファイルをすべてコピーします。 

21. PWMExample01 プロジェクト用に PSoC Creator の Workspace Explorer で新しいフォルダを作成し、

「LinkerScripts」と名前を付けます。 

22. 次のファイルを PSoC Creator PWMExample01 プロジェクトの Workspace Explorer 内の LinkerScripts フォルダ 

(ステップ 21で作成した) に追加します。ファイル システムでは、これらのファイルはステップ 0で作成した LinkerScripts

フォルダにあります。 

▪ cm0gcc.ld ▪ Cm0Mdk.scat 

23. 表 7に示す設定が PWMExample01のビルド設定に適用されていることを確認します。これらの変更は、新しいカスタム 

リンカー スクリプトを使用するようにリンカーに指示します。ビルド設定を変更するには、Project > Build Settings…を

選択し、図 23 に示すように、ツリー ビュー ウィンドウで PWMExample01 > ARM GCC 4.9-2015-q1-update > 

Linker > Generalを選択します。 

表 7. ビルド設定の変更 

フィールド 値 

Custom Linker Script .\LinkerScripts\cm0gcc.ld 

図 23. Build Settingsダイアログのリンカー設定 
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24. Bootloader／Bootloadable コンポーネントを追加した後、デバッグの対応は PSoC Creator で無効になります。しかし、

ファームウェアが実行を開始すると、ファームウェアをデバッグするために、ターゲット デバイスに接続し (Debug > 

Attach to Running Target…)、または UART メッセージングを使用します。UARTデバッグを有効／無効にする方法

は「デバッグ」を参照してください。UART が有効のとき、プロジェクトが正常に実行されるように十分なヒープ (0x400 バ

イト) とスタック (0×800バイト) が設定されたことを確認してください。そうしないと、ファームウェアは予測できない動作と

なる場合があります。詳細は「デバッグ」を参照してください。 

25. PWMExample01プロジェクトをビルドします。プロジェクトはエラーなしでビルドされます。 

26. メニュー項目の Debug > Programを選択して PSoC BLE Pioneer Kitをプログラムします。 

プログラミングが完了した後、緑色 LED は高輝度から低輝度まで周期的に繰り返します。ここで、「OTA アップグレードの実

行」で述べた方法の 1 つで、デバイス ファームウェアのアップグレードを実行できます。また、「OTA 機能のテスト」で述べた

手順に従って、OTA機能のテストもできます。 

BLE_OTA_UpgradableStackExample_Stack01.cyacd (スタック イメージ) および PWMExample01.cyacd (アプリケー 

ション イメージ) の 2個のブートローダブル イメージが使用可能です。アプリケーションをアップグレードするには、アプリケー

ション イメージ ファイルを使用してアップグレードを実行します。スタックをアップグレードするには、スタック イメージ ファイル

を使用してアップグレードを実行します。ターゲット デバイスとの接続を再確立してから、アプリケーションのアップグレードを

実行します。 

6 OTAアップグレードの実行 

サイプレスは 3 種類のホスト  アプリケーションを提供し、これらのアプリケーションを介してターゲット  デバイスの 

ファームウェアをアップグレードできます。ターゲット デバイスで実装した OTA 方法にかかわらず、すべての 3 つのホストは

OTAアップグレードを実行するために互換的に使用できます。 

OTA アップグレードを実行するために、ターゲット プラットフォームは「外部メモリ OTA ブートローダの追加」、「固定スタック

OTA ブートローダの追加」、または「アップグレード可能スタック OTA ブートローダの追加」で説明されたプロセスの 

終わりに生成される HEXファイルで事前にプログラムする必要があります。ビルド プロセスは (ブートローダブル プロジェクト

出力ディレクトリに、HEX ファイルと共に) ブートローダブル／アプリケーションン イメージである.cyacd ファイルも生成します。 

特定の種類の OTA ブートローダを使用するプロジェクトから得られた .cyacd ファイルは、他の OTA ブートローダが 

プログラムされたデバイスをアップグレードする目的には使用できません。例えば、外部メモリ OTA ブートローダを使用する 

プロジェクトからの.cyacdファイルは、固定スタック OTAブートローダがプログラムされたデバイスでは機能しません。 

PC ベースのファームウェア アップグレード方法が正常に機能するために、CySmart USB ドングルが必要です (図 24 を 

参照してください)。これは PSoC 4 BLE Pioneer Kitに同梱されています。 

図 24. CySmart USB ドングル 
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6.1 Bootloader Host ツールによるアップグレード 

Bootloader Hostツール (図 25を参照してください) は PSoC Creatorで提供され、BLE OTAアップグレードを含むさまざま

なデバイスのファームウェア アップグレード動作のために使用できます。Bootloader Host ツールを使用して OTA ベースの

デバイス ファームウェア  アップグレードを実行するために、以下の手順に従ってください。進む前に CySmart USB 

ドングルを PCに差し込んだことを確認してください。 

注: CySmart 1.2 ドングル ファームウェアのリリースによって、Bootloader Host ツールはもはや OTA をサポートして 

いません。 

1. CySmart USB ドングル (図 24に示されるもの) を PCの USBポートに接続します。 

図 25. Bootloader Hostツール 
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2. PSoC 4 BLE Pioneer Kit 上の SW2 スイッチを押して、赤色 LED で示されるブートローダ モードにデバイスを移行 

させます。特定要件に合わせるために、ブートローダ モードに移行する方法を再実装できます (例えば、特定の BLE 

特性書き込みコマンドでブートロード プロセスをトリガーできます)。 

アップグレード可能スタック OTA を実装するとき、OTA プロセスがまだ開始していない場合、40 秒後にブートロード 

モードがタイムアウトします。外部メモリ OTA および固定スタック OTA の実装の場合、タイムアウトはなく、ファーム 

ウェアはブートロード モードで無制限に待ちます。 

3. PSoC Creatorで Tools > Bootloader Hostを選択して Bootloader Hostツールを開きます。 

4. Open (図 25 を参照してください) をクリックし、*.cyacd ファイルへのパスを指します。このファイルはプロジェクト 

フォルダ ([project folder]\CortexM0\[compiler name]) に格納されています。 

5. Bootloader Hostツールで、Ports下にリストされる Cypress BLE Dongleを選択します。図 25を参照してください。 

6. 図 25に示すように、Scanned Devicesフィールドの隣にある Start Scanボタンをクリックします。 

7. 期待するデバイス (外部メモリ OTA／固定スタック OTA) が Scanned Devices に表示されるまで待ち、それを選択 

します (図 25を参照してください)。 

8. Stop Scanボタンをクリックします (図 25を参照してください)。 

9. Bootloader Host ツールで Program をクリックし (図 25 を参照してください)、新しいアプリケーション イメージの 

アップロードが完了するまで待ちます。 

ファームウェア  アップグレードが完了した後、デバイスは自動的にリセットし、緑色 LED が点滅します。詳細は

PWMExampleプロジェクトのデータシートを参照してください。 

6.2 CySmart PCツールによるアップグレード 

CySmart は Windows PC 用の BLE ホスト エミュレーション ツールです。使いやすい GUI を使用することで、ユーザーは

BLE ペリフェラル アプリケーションのテストおよびデバッグを実行できます。CySmart PC ツールをダウンロードできます。

CySmartの詳細は同じ場所にあるユーザー ガイドを参照してください。 

CySmart PCツールを使って OTAベースのデバイス ファームウェア アップグレードを実行するために、以下の手順に従って

ください。進む前に CySmart USB ドングルを PCに差し込んだことを確認してください。 

1. CySmart USB ドングル (図 24に示されるもの) を PCの USBポートに接続します。 

2. PSoC 4 BLE Pioneer Kit 上の SW2 スイッチを押して、赤色 LED で示されるブートローダ モードにデバイスを移行 

させます。特定要件に合わせるために、ブートローダ モードに移行する方法を再実装できます (例えば、特定の BLE 

特性書き込みコマンドでブートロード プロセスをトリガーできます)。 

3. CySmart ツールを開いて、「CySmart User Guide」の「2.7. Updating Peripheral Device Firmware」で述べた手順に 

従ってイメージをダウンロードします。 

ファームウェア  アップグレードが完了した後、デバイスは自動的にリセットし、緑色 LED が点滅します。詳細は

PWMExampleプロジェクトのデータシートを参照してください。 

CySmart PCツールで OTAアップグレードを実行するとき、ブートロード プロセスの終了時に Write characteristic value 

timed out エラーが発生することがあります (図 26 を参照してください)。ここで、ブートロード プロセス自体は失敗でなく、 

ユーザーがこのエラーを無視できることに注意してください。 

http://www.cypress.com/
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図 26. ブートロード プロセス終了時の「Write Characteristic Value Timed Out」エラーのダイアログ 

 

6.3 CySmartモバイル アプリによるアップグレード 

CySmart モバイル アプリはサイプレス セミコンダクタ社が開発した BLE または Bluetooth Smart ユーティリティです。

CySmart はさまざまな BLE製品との接続に使用し、また CY8CKIT-042-BLE PSoC 4 BLE Pioneer Kit、CY5672 PRoC 

BLE リモコン リファレンス デザイン キットおよび CY5682 PRoC BLE タッチマウス リファレンス デザイン キットを含む 

サイプレスの BLE 開発キットと共に使用できます。CySmart モバイル アプリは iOS®および Android™に対応しています。 

それらは www.cypress.com/cysmartmobile からダウンロードできます。詳細は同じ場所にあるユーザー  ガイドを 

参照してください。 

6.3.1 iOS からのアップグレード  

CySmart iOS アプリケーションを使って OTA ベースのデバイス ファームウェア アップグレードを実行するために、以下の 

手順に従ってください。進む前に、CySmart iOS アプリがユーザーのモバイル／タブレット デバイスにインストールされたこと

を確認してください。また、新アプリケーション イメージ (PWMExample01.cyacd) がモバイル デバイスにあることを確認して

ください。 

1. PSoC 4 BLE Pioneer Kit 上の SW2 スイッチを押して、赤色 LED で示されるブートローダ モードにデバイスを移行 

させます。 

2. iOSデバイスの CySmartアプリを起動し、「CySmart iOS App User Guide」の「2.1.2.3. Cypress Bootloader Service」

で述べた手順に従ってイメージをダウンロードします。 

6.3.2 Android からのアップグレード  

CySmart Android アプリを使って OTA ベースのデバイス ファームウェア アップグレードを実行するために、以下の手順に 

従ってください。進む前に、CySmart Android アプリがユーザーのモバイル／タブレット デバイスにインストールされたことを

確認してください。また、新アプリケーション  イメージ  (PWMExample01.cyacd) がモバイル  デバイスにあることを 

確認してください。 

1. PSoC 4 BLE Pioneer Kit 上の SW2 スイッチを押して、赤色 LED で示されるブートローダ モードにデバイスを 

移行させます。 

2. Android デバイスの CySmart アプリケーションを起動し、「CySmart Android App User Guide」の「2.1.2.3. Cypress 

Bootloader Service」で述べた手順に従ってイメージをダウンロードします。 

ファームウェア  アップグレードが完了した後、デバイスは自動的にリセットし、緑色 LED が点滅します。詳細は

PWMExampleプロジェクトのデータシートを参照してください。 

7 OTA機能のテスト 

OTA機能をテストするために、以下の手順に従ってください。 

http://www.cypress.com/
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1. PWM サンプル  プロジェクトの main.c では、BRIGHTNESS_DECREASE マクロの値を 1000 に変更します。 

詳細は PWMExampleプロジェクトのデータシートを参照してください。 

2. PWMExample プロジェクトを再度ビルドします (Build > Build PWMExample01)。すると、新しい.cyacd ファイルが 

生成されます。 

3. 「OTA アップグレードの実行」で記述される OTA アップグレード方法のいずれかに従ってください。ステップ 2 で 

出力された PWMExample.cyacdファイルの選択を確認してください。 

ファームウェア アップグレードが完了した後、デバイスは自動的にリセットし、緑色 LED 輝度調光はより速い速度で 

繰り返します。 

BRIGHTNESS_DECREASE マクロを 0～63000 範囲の値に変更し、上記の手順に従って、異なる結果を観察します。値が小

さいほど輝度調光サイクル速度が遅くなり、値が大きいほど輝度調光サイクル速度が速くなります。 

8 その他の注意事項 

8.1 ボンディング／ペアリングの情報 

BLE コンポーネントでボンディングを有効にする方法を提供します。また、ボンディング／ペアリング情報に対する 3 種類の

OTAアップグレードの影響を説明します。 

ボンディングを有効にするには、Configure BLEダイアログの GAP Settingsの下の Securityで Bonding requirement

を Bondingオプションに選択します (図 27を参照してください)。 

図 27. ボンディング情報保持のための BLEコンポーネントの設定 
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フラッシュ書き込み中には、割り込みの許可／処理ができないため、フラッシュ書き込みは都合の良いときにアプリケーション

によって処理する必要があります。フラッシュ書き込みイベントが保留中になるたびに cyBle_pendingFlashWrite 変数

はスタックによって設定されます。アプリケーションは、このフラグの状態を CyBle_StoreBondingData API と共に 

チェックすることにより、ボンディング情報を書き込めます。コード 2を参照してください。 

コード 2. アプリケーション レベルのボンディング情報の書き込み 

   if((cyBle_pendingFlashWrite != 0u)) 

   { 

       #if (DEBUG_UART_ENABLED == YES) 

           CYBLE_API_RESULT_T apiResult; 

           apiResult = CyBle_StoreBondingData(0u); 

           DBG_PRINTF("Store bonding data, status: %x \r\n", apiResult); 

       #else 

            (void)CyBle_StoreBondingData(0u); 

      #endif /* (DEBUG_UART_ENABLED == YES) */ 

   } 

次の節では、各 OTAブートローダ種類に特有のボンディング／ペアリング情報を提供します。 

8.1.1 外部メモリ OTA ブートローダ  

外部メモリ OTA ブートローダでは、ボンディング情報はアプリケーション (ブートローダブル) プロジェクトで処理されます。 

そのため、アップグレード後にボンディング情報全体が失われます。 

8.1.2 固定スタック OTA ブートローダ  

固定スタック OTA ブートローダの場合、ボンディング情報はブートローダ プロジェクトの範囲に割り当てられます。したがって、

ブートローダブル プロジェクトがアップグレードされた後でも、ボンディング情報は変わらないままですが、デバイスがシリアル 

ワイヤ デバッグ (SWD) プログラマで再プログラムされる場合にのみ消去されます。 

8.1.3 アップグレード可能スタック OTA ブートローダ  

アップグレード可能スタック OTAブートローダの場合、ボンディング情報はスタック (任意) およびアプリケーション イメージの

両方に格納されます。デフォルトではボンディング情報はスタックによって格納されません。クライアント特性コンフィギュ 

レーション ディスクリプタ (CCCD) が変更されない限り、アプリケーションのアップグレードはアプリケーションのボンディング

情報に影響を与えません。スタックをアップグレードすると、アプリケーションのボンディング情報は失われます。 

8.2 デバッグ 

プロジェクトに 1 個の OTA ブートローダを追加した後、PSoC Creator からプロジェクトをデバッグするオプションは無効に 

なります。しかし、ファームウェアの実行が開始されると、デバッグのためにターゲット デバイスに接続できます (Debug > 

Attach to Running Target…)。この方法を使用する場合、1 回にただ 1 つのプロジェクトだけはデバッグできます。 

間違ったプロジェクトから行う場合、実行中のターゲット デバイスへの接続はデバイスを再プログラムする可能性があります。

また、デバッガをターゲット デバイスに接続するために、SWD インターフェースは有効にする必要があります。プロジェクトの

SWD インターフェースは、使用されるプロジェクトの.cydwr ファイル (例: PWMExample01.cydwr) で Debug Select を

SWD に変更することにより有効にされます (図 28 を参照してください)。.cydwr ファイルはプロジェクトの Workspace 

Explorerからアクセスできます。 

SWD インターフェースはデバッグのために利用できない場合、GPIO トグル、任意のシリアル通信インターフェースまたは

UART などのプロトコルを使用してください。それを実現するために、PSoC Creator の OTA サンプル プロジェクトは 

ソフトウェア UART (TX のみ) コンポーネントを利用します。ユーザーがブートローダブル プロジェクトを作成するために

PSoC Creatorサンプル プロジェクトから debug.cおよび debug.hファイルを取得したため (「ターゲット プロジェクトへのファ

ームウェア OTAブートローダの追加」を参照してください)、この機能を使ってこれらのプロジェクトをデバッグできます。 

コード 3 に示すように、Options.h ヘッダ ファイルにある DEBUG_UART_ENABLED マクロを YES に設定することで、 

あらゆる OTAプロジェクトで UARTデバッグを有効にすることができます。 

コード 3. Options.hの DEBUG_UART_ENABLED マクロ 

#define DEBUG_UART_ENABLED (YES) 
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OTAの例では、UARTを介してメッセージを送信するために printf 文 (直接またはマクロの定義) を使用します。printf

は、正常の実行のためにかなりのヒープとスタック空間を必要とします。したがって、DEBUG_UART_ENABLED マクロが 

有効のとき、アプリケーションが正常に機能するために十分なヒープとスタック メモリを割り当てる必要があります。それを 

実現するために、Workspace Explorer からユーザーのプロジェクトの.cydwr ファイル (例えば、PWMExample01.cydwr) 

をダブルクリックし、それを開いて、System タブに移動します (図 28 を参照してください)。適切な Heap Size および Stack 

Sizeを設定します (Heap Sizeを 0x400バイトに、Stack Sizeを 0x800バイトに設定することはサンプル プロジェクトでの

良いスタート ポイントです)。 

図 28. PSoC Creatorの Heap Sizeおよび Stack Sizeの変更 

 

8.3 データ長拡張 (DLE) 

Bluetooth SIGは Bluetoothコア仕様 4.2で LEデータ パケット長拡張またはデータ長拡張 (DLE) を提供します。この機能

により、リンク層の最大データ チャネル ペイロード長は 27バイト (Bluetoothコア仕様 4.1またはそれ以前) から 251バイト

に増えます。したがって、リンク層データ パケットの容量が約 10 倍、リンクのスループットが約 2.6 倍増加します。サイプレス

のデバイスがサポートしている DLEおよび Bluetoothコア仕様 4.2の他の機能の詳細は AN99209を参照してください。  

DLE 機能は、BLE コンポーネント Ver. 3.0 以降で利用可能であり、Bluetooth コア仕様 4.2 に準拠するすべてのサイプレス 

デバイスによってサポートされます。以下の手順を行うことで、DLE はいかなる BLE プロジェクトでも (OTA プロジェクトを 

含む) 有効にできます。 

1. BLEコンポーネントをダブルクリックして BLEコンポーネント コンフィギュレーション ダイアログを開きます。 

2. GAP Settings タブで、Link layer max TX payload size (bytes) および Link layer max RX payload size (bytes) 

の値を 27～251範囲内の値に変更します (図 29を参照してください)。 

http://www.cypress.com/
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図 29. BLEコンポーネントの GAP Settingsタブ 

 

8.4 データの永続性 

8.4.1 SFlash の使用  

PSoC と PRoC BLE 両方のデバイスはユーザーSFlash 領域があります。SFlash はフラッシュ保護設定、トリム設定などの

情報を格納するために使用されます (ユーザーはこれらの情報にアクセスできません)。また SFlash には、Bluetooth または

製品固有の情報 (デバイス アドレス、製造／シリアル番号、センサー較正データなど) を格納するために使用できる、ユーザ

ー設定可能な 4行があります。これらのユーザー設定可能な行はプログラミング サイクル中または OTAのアップグレード中

に消去されないため、データの永続性を提供します。さらに、SFlash は、ファームウェア プログラミングから独立した製造 

サイクル中には書き込めます。SFlash のユーザー設定可能な行はファームウェアまたは SWD プログラミング インター 

フェースを介してアクセスできます。 

ユーザーSFlashの読み出し／書き込みのサンプル プロジェクトはこちらで入手可能です。この機能をユーザーのプロジェクト

で実装する方法は、プロジェクトのユーザー ガイドを参照してください。このサンプル プロジェクトは 128KB BLE デバイスで

実装されます。表 8に、すべての BLEデバイスのパラメーター情報を示します。 

  

http://www.cypress.com/
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表 8. SFlashサンプル プロジェクトのデバイス固有パラメーター 

パラメーター 128KBデバイス 256KBデバイス 

USER_SFLASH_ROW_SIZE 128 256 

USER_SFLASH_ROWS 4 4 

USER_SFLASH_BASE_ADDRESS 0x0FFFF200u 0x0FFFF400u 

8.4.2 チェックサム除外の使用  

ブートローダブル アプリケーションのチェックサム計算からフラッシュの一部を除外できます。このフラッシュ領域は、ユーザー

またはコンポーネントのデータを格納するために使用できます (例えば、この方法で BLEはペアリング データを格納します)。

チェックサム除外の詳細はブートローダブル コンポーネント データシートを参照してください。この機能を有効にするには、 

下記のステップを従ってください。 

1. ターゲット データを cy_checksum_exclude 領域に移動させます。以下のサンプル コードを参照してください。 

コード 4. GCCコンパイラの cy_checksum_exclude の例 

const uint8 byteArray[10] CY_SECTION(".cy_checksum_exclude") =  

          {0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00}; 

 

コード 5. MDKコンパイラの cy_checksum_exclude の例 

const uint8 byteArray[10] CY_SECTION(".cy_checksum_exclude") =  

          {0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00}; 

 

コード 6. IARコンパイラの cy_checksum_exclude の例 

#pragma location=".cy_checksum_exclude" 

const uint8 byteArray[10] =  

          {0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00}; 

 

2. General タブの Bootloadable コンポーネントでは、Checksum exclude section size (bytes) を必要な値に 

設定します (コード 4、5、および 6では 10バイト)。図 30を参照してください。 

図 30. Bootloadableコンポーネント ダイアログ 
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3. カスタム リンカー スクリプト (LinkerScripts フォルダにある cm0gcc.ld) が使用されている固定スタック OTA ブート 

ローダに対して、チェックサム除外の情報は手動で追加する必要があります。このために、次のステップを行ってください。 

a. Bootloadable コンポーネントで Checksum exclude section size (bytes) が設定されると、プロジェクトを 

クリーンにして (Build > Clean PWMExample01)、生成します  (Build > Generate Application)。これは

.\PWMExample01.cydsn\Generated_Source\PSoC4に新しいリンカー スクリプト ファイルを作成します。また、

それらのファイルは PSoC Creator Workspace Explorerで Generated Source > PSoC 4 > cy_bootからも 

アクセスできます。 

b. カスタム リンカー スクリプト ファイルを開きます。固定スタック OTA サンプル プロジェクトでは、このファイルは

\PWMExample01.cydsn\LinkerScripts に あ り ま す 。 ま た 、 PSoC Creator Workspace Explorer で

PWMExample01 > LinkerScriptsからもアクセスできます。 

c. PSoC Creatorが生成したリンカー スクリプトで CY_CHECKSUM_EXCLUDE_SIZE リンカー スクリプト変数を検索し

ます。カスタム リンカー スクリプトにも同じ変更を加えます。例えばこの場合、以下のとおりに 10 バイトを 

除外する必要があります。 

コード 7. GCCの cm0gcc.ldリンカー スクリプトの CY_CHECKSUM_EXCLUDE_SIZE 変数 

CY_CHECKSUM_EXCLUDE_SIZE        = ALIGN(10, CY_FLASH_ROW_SIZE); 

 

コード 8. IARの Cm0Iar.icfリンカー スクリプトの CY_CHECKSUM_EXCLUDE_SIZE 変数 

define symbol CY_CHECKSUM_EXCLUDE_SIZE = 10; 

 

コード 9. MDKの Cm0RealView.scat リンカー スクリプトの CY_CHECKSUM_EXCLUDE_SIZE 変数 

#define CY_CHECKSUM_EXCLUDE_SIZE        AlignExpr(10, CY_FLASH_ROW_SIZE) 

 

d. この変更を行ってから、リンカー  スクリプト  ファイルを保存し、プロジェクトをビルドします  (Build > 

PWMExample01)。 

9 まとめ 

本アプリケーション ノートは、OTA の異なる種類および、それらのアプリケーションでの実装方法について説明しました。また、

OTA アップグレード機能およびサイプレスが提供するツールを使ってターゲット デバイスのファームウェアを更新する方法に

ついても説明しました。 

10 関連アプリケーション ノート 

AN86526 – PSoC 4 I2C Bootloader 

AN73854 – PSoC 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders 

AN68272 – PSoC 3, PSoC 4, and PSoC 5LP UART Bootloader 

AN91267 – Getting Started with PSoC 4 BLE 

AN94020 – Getting Started with PRoC BLE 
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A 付録 A 

A.1 サンプル プロジェクト ワークスペースの作成 

1. 図 31 に示すように、PSoC Creator で File > Code Example…を選択し、Find Example Project ダイアログを 

開きます。 

2. 図 31に示すように、必要な Device Familyおよび Filter byキーワードを適用して検索を絞り込みます。 

3. 任意のサンプル プロジェクトを選択し、Create Projectボタンをクリックします。 

図 31. Find Code Exampleプロジェクト ダイアログ - サンプル プロジェクト ワークスペースの作成 

 

4. Workspace フィールドで Create New Workspace オプションを選択します。新しいサンプル  プロジェクトの 

ワークスペース用に Locationを選択し (図 32を参照してください)、Finishをクリックします。 

5. 必要なパスを選択し、Finishをクリックします。 

2 

3 
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図 32. Create Projectダイアログ - サンプル プロジェクト ワークスペースの作成 

 

これらのステップが完了したとき、選択した場所にワークスペースが作成されます。選択したサンプル  プロジェクトはこの 

ワークスペースに追加されます。データシート (<project_name>.pdf) は新しく作成したプロジェクトの下にあります。サンプル 

プロジェクトの詳細はこの資料を参照してください。 

A.2 既存のワークスペースへのサンプル プロジェクトの追加 

本節のステップを行う前に、PSoC Creator のインスタンスで Project/Workspace が開いていることを確認してください。 

既存の Project/Workspaceを開くには、 File > Open > Project/Workspaceを選択します。 

1. 図 33に示すように、File > Code Example…を選択し、Find Example Projectダイアログを開きます。 
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図 33．Find Example Projectダイアログ – 既存のワークスペースへのサンプル プロジェクトの追加 

 

2. 図 33に示すように、必要な Device familyおよび Filter byキーワードを適用して検索を絞り込みます。 

3. 任意のサンプル プロジェクトを選択し、Create Projectボタンをクリックします。 

4. Workspace フィールドで Add to current workspace オプションを選択します。新しいサンプル プロジェクトの 

ワークスペース用に Locationを選択して(図 34を参照してください)、Finishをクリックします。 

5. 必要なパスを選択し、Finishをクリックします。 

これらのステップが完了すると、選択したサンプル  プロジェクトは PSoC Creator のインスタンスで既に開いている 

ワークスペースに追加されます。データシート (<project_name>.pdf) は新しく追加したプロジェクトの下にあります。サンプル 

プロジェクトの詳細はこの資料を参照してください。 

  

2 

3 
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図 34. Create Projectダイアログ – 既存のワークスペースへのサンプル プロジェクトの追加 

 

A.3 他のデバイス選択 

1. PSoC Creatorで、Project > Device Selector…を選択します (図 35を参照してください)。 

図 35. Device Selectorの起動 

 

 

2. 図 36に示すように、Family フィルター カテゴリで PSoC 4200 BLE、PSoC 4100 BLE、および PRoC BLE フィルター項目を 

有効にします。 
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図 36．デバイス ファミリの選択 

 

3. リストからユーザーのアプリケーションに適切な BLE デバイスを選択します。ユーザーのターゲット  デバイスが

CY8CKIT-042-BLE Pioneer Kit に同梱されている PRoC BLE または PSoC 4 BLE モジュールであれば、図 37 に 

示すように、Familyフィルターを右クリックして、Select Default Deviceを選択し、適切なデバイス ファミリを選びます。 

図 37. CY8CKIT-042-BLE Pioneer Kitのデフォルト PRoC BLEデバイスの選択 

 

 

4. OKをクリックして、Device Selectorを閉じます。 
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A.4 ブートローダ サービスの追加 

既存の BLEコンポーネントにブートローダ サービスを追加するには、以下の手順に従ってください。ブートローダ サービスの

詳細は BLEコンポーネント データシートを参照してください。 

1. BLEコンポーネントをダブルクリックしてコンフィギュレーション ダイアログを開きます (図 38を参照してください)。 

2. Profiles タブに移動してサービス／プロファイルを選択します (例えば、図 38の HID Deviceなど)。 

3. Add Service をクリックし (図 38 を参照してください)、利用可能なサービスを表示して、Bootloader を選択します 

(図 39を参照してください)。 

4. Bootloader > Command > Fields下の Dataフィールドを 137に設定します (図 40を参照してください)。 

5. Security level (GAP Settings > Security タブの下にある) を Unauthenticated pairing with encryption に 

設定します (図 41を参照してください)。この設定は PSoC Creator提供のサンプル プロジェクトによって使用され、正常

動作のために本アプリケーション ノートの手順に必要です。あるいは、更新の実行中に更新ツール (CySmart) 用に 

セキュリティ オプション (コンポーネントで選択される) を使用します。このステップは必須ではありません。 

図 38. BLEコンポーネント コンフィギュレーション ダイアログ 
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図 39. ブートローダ サービスの選択 

 

図 40．ブートローダ サービス データ フィールドに 137の設定 

 

http://www.cypress.com/


  PSoC® 4 BLEおよび PRoC™ BLE – 無線 (OTA) のデバイス ファームウェア アップグレード (DFU) ガイド 

www.cypress.com 文書番号: 002-15741 Rev.*B 47 

図 41. セキュリティ オプションの変更 

  

A.5 サイプレスの他の BLEデバイス用の固定スタック OTAプロジェクトの設定 

BLE OTA 固定スタックのサンプル プロジェクトはカスタムのリンカー スクリプトを使用するため、PSoC Creator は正しい 

リンクと配置を提供するためにリンカー スクリプトを設定できません。ここでは、CY8C4247LQI-BL483 や CYBL10563-

56LQXIデバイスを使用していない、または異なる RAM／ROM メモリ サイズを持つデバイスを使用している場合に従う必要

がある手順を説明します。デフォルトで、リンカー スクリプトは 128KBデバイス用の設定があります。 

次の節では、PSoC Creatorでデバイスを変更した後にリンカー スクリプトを修正することについて説明します。 

A.5.1  GCC コンパイラ  

GCCコンパイラの場合、以下のようにブートローダおよびブートローダブル リンカー スクリプトの両方に変更が必要です。 

1. 256KBデバイスの場合、デバイスのフラッシュ メモリ サイズを 262144に変更します (図 42を参照してください)。 

2. 256KBデバイスの場合、デバイスの RAMサイズを 32768に変更します (図 42を参照してください)。 

3. 256KBデバイスの場合、デバイスの行サイズを 256に変更します (図 42を参照してください)。 
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図 42. 128KBデバイス用のコンフィギュレーションを示す cm0gcc.ldファイルの内容 

 

ブートローダ プロジェクトのリンカー スクリプトは\cm0gcc.ld、ブートローダブル プロジェクトのリンカー スクリプトは

\LinkerScripts\cm0gcc.ldにあります。 

ユーザーのデバイス用に入力する値がわからない場合、PSoC Creator よって生成されるリンカー スクリプト (使用される 

かどうかにかかわらず) にある値を参照してください。これは%PROJECT_DIR%\Generated_Source\PSoC4\cy_boot 

フォルダにあり、cm0gcc.ldとして名付けられます。 

A.5.2  MDK コンパイラ  

MDK コンパイラの場合、ブートローダブル プロジェクトのリンカー スクリプトのみは変更する必要があります。リンカー 

スクリプトは\LinkerScripts\Cm0Mdk.scatフォルダにあります。 

1. 256KBデバイスの場合、デバイスのフラッシュ メモリ サイズを 262144に変更します (図 43を参照してください)。 

2. 256KBデバイスの場合、デバイスの行サイズを 256に変更します (図 43を参照してください)。 

図 43. 128KBデバイス用のメモリおよび行サイズを示す Cm0Mdk.scatファイルの内容 

 

3. 256KBデバイスの場合、デバイスの RAMサイズ (両方の値) を 32768に変更します (図 44を参照してください)。 

図 44. 128KBデバイス用の RAMサイズを示す Cm0Mdk.scatファイルの内容  
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ユーザーのデバイス用に入力される値がわからない場合、PSoC Creator よって生成されるリンカー  スクリプト  

(プロジェクトが再ビルドされた後に使用されるどうかにかかわらず ) にある値を参照してください。これは 

%PROJECT_DIR%\Generated_Source\PSoC4\cy_bootフォルダにあり、Cm0Mdk.scatとして名付けられます。 

A.5.3  IAR コンパイラ  

IAR を使用する場合、ブートローダ プロジェクトのリンカー スクリプトに対して、PSoC Creator でデバイスが変更された後に

PSoC Creator によって生成されるリンカー スクリプトを使用しても問題ありません。しかし、ブートローダブル プロジェクトの 

リンカー スクリプトを修正する必要があります。これは\LinkerScripts\Cm0Iar.icfフォルダにあります。 

1. 256KBデバイスの場合、デバイスのフラッシュ メモリ サイズを 262144に変更します (図 45を参照してください)。 

2. 256KBデバイスの場合、デバイスの RAMサイズを 32768に変更します (図 45を参照してください)。 

3. 256KBデバイスの場合、デバイスの行サイズを 256に変更します (図 45を参照してください)。 

図 45. 128KBデバイスのコンフィギュレーションを示す Cm0Iar.icfファイルの内容 

 

ユーザーのデバイス用に入力される値がわからない場合、PSoC Creator よって生成されるリンカー スクリプト (プロジェクト

が 再 ビ ル ド さ れ た 後 に 使 用 さ れ る ど う か に か か わ ら ず ) に あ る 値 を 参 照 し て く だ さ い 。 

これは%PROJECT_DIR%\Generated_Source\PSoC4\cy_bootフォルダにあり、Cm0Iar.icfとして名付けられます。 
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して間接のいずれかで) 本ソフトウェアをバイナリーコード形式で外部エンドユーザーに配布すること, 並びに (2) 本ソフトウェア (Cypressにより提供され, 修正がなされていないもの) が

抵触する Cypress の特許権のクレームに基づき, Cypress ハードウェア製品と共に用いるためにのみ, 本ソフトウェアの作成, 利用, 配布及び輸入を行うことについての非独占的で譲渡

不能な一身専属的ライセンス (サブライセンスの権利を除く) を付与する。本ソフトウェアのその他の使用, 複製, 修正, 変換又はコンパイルを禁止する。 

適用される法律により許される範囲内で, Cypressは, 本書面又はいかなる本ソフトウェア若しくはこれに伴うハードウェアに関しても, 明示又は黙示をとわず, いかなる保証 (商品性及び

特定の目的への適合性の黙示の保証を含むがこれらに限られない) も行わない。いかなるコンピューティングデバイスも絶対に安全ということはない。従って, Cypress のハードウェアま

たはソフトウェア製品に講じられたセキュリティ対策にもかかわらず, Cypressは, Cypress製品への権限のないアクセスまたは使用といったセキュリティ違反から生じる一切の責任を負わ

ない。加えて, 本書面に記載された製品には, エラッタと呼ばれる設計上の欠陥またはエラーが含まれている可能性があり, 公表された仕様とは異なる動作をする場合がある。適用される

法律により許される範囲内で, Cypressは, 別途通知することなく, 本書面を変更する権利を留保する。Cypressは, 本書面に記載のある, いかなる製品若しくは回路の適用又は使用から

生じる一切の責任を負わない。本書面で提供されたあらゆる情報 (あらゆるサンプルデザイン情報又はプログラムコードを含む) は, 参照目的のためのみに提供されたものである。この情

報で構成するあらゆるアプリケーション及びその結果としてのあらゆる製品の機能性及び安全性を適切に設計, プログラム, かつテストすることは, 本書面のユーザーの責任において行わ

れるものとする。Cypress製品は, 兵器, 兵器システム, 原子力施設, 生命維持装置若しくは生命維持システム, 蘇生用の設備及び外科的移植を含むその他の医療機器若しくは医療シス

テム, 汚染管理若しくは有害物質管理の運用のために設計され若しくは意図されたシステムの重要な構成部分としての使用, 又は装置若しくはシステムの不具合が人身傷害, 死亡若しく

は物的損害を生じさせるようなその他の使用 (以下「本目的外使用」という。) のためには設計, 意図又は承認されていない。重要な構成部分とは, それの不具合が装置若しくはシステム

の不具合を生じさせるか又はその安全性若しくは実効性に影響すると合理的に予想できるような装置若しくはシステムのあらゆる構成部分をいう。Cypress 製品のあらゆる本目的外使用

から生じ, 若しくは本目的外使用に関連するいかなる請求, 損害又はその他の責任についても, Cypressはその全部又は一部をとわず一切の責任を負わず, かつ Cypressはそれら一切

から本書により免除される。Cypress は Cypress 製品の本目的外使用から生じ又は本目的外使用に関連するあらゆる請求, 費用, 損害及びその他の責任 (人身傷害又は死亡に基づく

請求を含む) から免責補償される。 

Cypress, Cypress のロゴ, Spansion, Spansion のロゴ及びこれらの組み合わせ, WICED, PSoC, CapSense, EZ-USB, F-RAM, 及び Traveo は, 米国及びその他の国における

Cypressの商標又は登録商標である。Cypressのより完全な商標のリストは, cypress.comを参照すること。その他の名称及びブランドは, それぞれの権利者の財産として権利主張がな

されている可能性がある。 
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